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QUESTION 1

Rick works as an Office Assistant for Tech Perfect Inc. He is creating a report through Microsoft Excel 2013. Rick wants
to interact with cell data but his computer does not contain VBA code and few features of his computer are still Excel 5.
0 features. Which of the following will Rick use to accomplish the task? 

A. Accounting template 

B. Trust Center 

C. Form control 

D. Evaluate Formula 

Correct Answer: C 

A form control is an original control that is compatible with old versions of Excel, beginning with Excel version 5. 0. It is
designed for use on XLM macro sheets. It can be used when a user wants to simply interact with cell data without using
VBA code and when he wants to add controls to chart sheets. By using form controls, the user can run macros. He can
attach an existing macro to a control, or write or record a new macro. These controls cannot be added to UserForms,
used to control events, or modified to run Web scripts on Web pages. Answer option A is incorrect. The accounting
template is used for numbering months of a financial year to period numbering. It is used to compare month to month,
actual v budget, quarter to quarter, year to year variances. It is the initial point for other reports that need the use of
months. Answer option D is incorrect. Evaluate Formula is the formula examination tool provided by Microsoft Excel.
This tool is useful for examining formulas that do not produce any error but are not generating the expected
result.Answer option B is incorrect. Trust Center is where a user can find security and privacy settings for Microsoft
Office 2013 programs. 

 

QUESTION 2

Rick works as an Office Assistant for Tech Perfect Inc. He is responsible for preparing sales 

reports of the company. He has created a sales report in a workbook of Excel 2013 and this workbook contains various
worksheets as shown in the image given below: 

Rick wants the sheet tabs of the sheets containing charts to appear in red color. Which of the following steps will Rick
take to accomplish the task? 

A. Select the sheets containing charts. Select the Colors option in the Themes group on the Page Layout page. 

B. Select the sheets containing charts. Right-click on the sheet tabs. 

C. Select the sheets containing charts. Right-click on the sheet tabs. Choose the Sheet Color Option from the shortcut
menu. 

D. Select the sheets containing charts. Select the Effects option in the Themes group on the Page Layout page. 

Correct Answer: B 

According to the question, Rick wants the sheet tabs of the sheets containing charts to appear in red color. In order to
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accomplish the task, he will take the following steps: 

1.

 Select the sheets containing charts. 

2.

 Right-click on the sheet tabs. Choose the Tab Color option from the shortcut menu. 

Answer options A and D are incorrect. These steps will not affect the appearance of the sheet tabs. Answer option C is
incorrect. This is an invalid answer option. 

 

QUESTION 3

You work as an Office Assistant for Tech Perfect Inc. The company has a Windows-based network. You are creating a
business report by using. Microsoft Excel 2013. You have arranged sales data as shown below: 
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You want to provide pictorial representation of the trend of the sales data in front of each row. 

Which of the following actions will you take to accomplish the task with the least amount of administrative burden? 

A. Use stand-alone slicers. 

B. Configure form controls. 

C. Create sparklines. 

D. Create a PivotTable report. 

Correct Answer: C 

 

In order to accomplish the task with the least amount of administrative burden, use sparklines. 

Sparklines, introduced in Microsoft Office 2013, are tiny charts that can fit in a cell. The sparklines can be used to show
trends in a small amount of space. The sparklines visually summarize trends alongside data. 

The sparklines can be added through the Insert tab. Answer option A is incorrect. Stand-alone slicers are referenced
from Online Analytical Processing (OLAP) Cube functions. These stand-alone slicers can be connected with any
PivotTable 

in future. 

They can be added by using the slicer button on the Ribbon. They need to be manually linked into grids as required. 

Answer option B is incorrect. A form control is an original control that is compatible with old versions of Excel, beginning
with Excel version 5. 0. It is designed for use on XLM macro sheets. It can be used when a user wants to simply

77-427 PDF Dumps | 77-427 Practice Test | 77-427 Study Guide                              4 / 16

https://www.pass2lead.com/77-427.html
https://www.pass2lead.com/77-427.html
https://www.pass2lead.com/77-427.html


https://www.pass2lead.com/77-427.html
2023 Latest pass2lead 77-427 PDF and VCE dumps Download

interact 

with cell data without using VBA code and when he wants to add controls to chart sheets. By using form controls, the
user can run macros. He can attach an existing macro to a control, or write or record a new macro. These controls
cannot 

be added to UserForms, used to control events, or modified to run Web scripts on Web pages. 

Answer option D is incorrect. A PivotTable report is used to summarize large amounts of data, to analyze numerical
data, and to answer unexpected questions about data. 

 

QUESTION 4

You work as an Office Assistant for Media Perfect Inc. You have created a spreadsheet in Excel 2013 and shared it with
the other employees of the company. You want to select password protection and select options to prevent other
employees from changing, moving, and deleting important data. 

Which of the following options will you choose to accomplish the task? 

A. Mark as Final 

B. Protect Current Sheet 

C. Encrypt with Password 

D. Protect Workbook Structure 

Correct Answer: D 

The various Protect Workbook options are as follows: 

1.

 Mark as Final: This option is used to make the document read-only. When a spreadsheet is marked as final, various
options such as typing, editing commands, and proofing marks are disabled or turned off and the spreadsheet becomes 

read-only. This command helps a user to communicate that he is sharing a completed version of a spreadsheet. This
command also prevents reviewers or readers from making inadvertent modifications to the spreadsheet. 

2.

 Encrypt with Password: When a user selects the Encrypt with Password option, the Encrypt Document dialog box
appears. In the Password box, it is required to specify a password. Microsoft is not able to retrieve lost or forgotten 

passwords, so it is necessary for a user to keep a list of passwords and corresponding file names in a safe place. 

3.

 Protect Current Sheet: This option is used to select password protection and permit or prohibit 

other users to select, format, insert, delete, sort, or edit areas of the spreadsheet. This option 

protects the worksheet and locked cells. 

4.
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 Protect Workbook Structure: This option is used to select password protection and select options to prevent users from
changing, moving, and deleting important data. This feature enables a user to protect the structure of the worksheet. 

5.

 Restrict Permission by People: This option works on the basis of Window Rights Management to restrict permissions. A
user is required to use a Windows Live ID or a Microsoft Windows account to restrict permissions. These permissions 

can be applied via a template that is used by the organization in which the user is working. These permissions can also
be added by clicking Restrict Access. 

6.

 Add a Digital Signature: This option is used to add a visible or invisible digital signature. 

It 

authenticates digital information such as documents, e-mail messages, and macros by using computer cryptography.
These signatures are created by specifying a signature or by using an image of a signature for establishing authenticity, 

integrity, and non-repudiation. 

 

QUESTION 5

You work as an Office Assistant for Tech Perfect Inc. You are working in the spreadsheet of the company\\'s high selling
products. You want to find out the matching values in the columns. While doing so, you get an unexpected error that
when you attempt to look up or match a lookup_value within an array; Excel is not able to recognize the matching value.
You want to store sets of values as text and convert sets of data to text by using Excel\\'s Text To Columns tool. Which
of the following steps will you take to accomplish the task? 

Each correct answer represents a part of the solution. Choose all that apply. 

A. Select the Text to Columns option from the Data tab at the top of the Excel workbook. 

B. Select Text and click the Finish button in Column Data Formats. 

C. Select the Delimited option and click Next 

D. Make sure that all delimiter options are unselected, and then again click Next. 

E. Remove the unseen spaces at the start or end of the first Macro cell. 

F. Select the cells to convert their data to text. 

Correct Answer: ABCDF 

In this situation, you will take the following steps: 

1.

 Select the cells to convert their data to text. 

2.

 Select the Text to Columns option from the Data tab at the top of your Excel workbook. 
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3.

 Select the Delimited option and click Next. 

4.

 Make sure that all delimiter options are unselected, and then again click Next. 

5.

 Select Text and click the Finish button in Column Data Formats. 

 

QUESTION 6

You work as an Office Assistant for Tech Tree Inc. You have created a report in a workbook in 

Microsoft Excel 2013. You want to export XMLdata to your Excel 2013 worksheet. On exporting the XML data, the
following error message appears: 

"XML MAPS IN MY WORKBOOK ARE NOT EXPORTABLE" 

Which of the following are the reasons that are causing the above error? Each correct answer represents a complete
solution. Choose all that apply. 

A. The maxoccurs attribute is not equal to 1. 

B. The relationship of the mapped element with other elements is not preserved. 

C. The element is a recursive structure. 

D. The XML map associated with this XML table contains one or more required elements that are not mapped to the
XML table. 

Correct Answer: AB 

The various issues with exporting XML data are as follows: 

1.

 MAP CAN BE EXPORTED BUT SOME REQUIRED ELEMENTS ARE NOT MAPPED: 

This error occurs under the following situations: 

The XML map associated with this XML table contains one or more required elements that are not mapped to the XML
table. The element is a recursive structure. The XML table contains a variety of mixed content. 

2.

 EXCEL CANNOT SAVE THE WORKBOOK BECAUSE IT DOES NOT CONTAIN ANY XML MAPPINGS: Excel cannot
save the user\\'s workbook in the XML Data file unless one or more mapped ranges are created. 

3.

 XML MAPS IN MY WORKBOOK ARE NOT EXPORTABLE: An XML mapping cannot be exported if the relationship of
the mapped element with other elements is not preserved due to the following reasons: 
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The mapped element\\'s schema definition is contained within a sequence with the following attributes: 

The maxoccurs attribute is not equal to 1. 

The sequence has more than one direct child element defined or has an extra compositor as a direct child. 

Nonrepeating sibling elements with the same repeating parent element are mapped to dissimilar XML tables. 

Various repeating elements are mapped to the same XML table and the recurrence is not defined by an ancestor
element. 

Child elements from various parents are mapped to the same XML table. XML schema constructs a list of lists,
denormalized data, or a choice construct. 

 

QUESTION 7

You work as an Office Assistant for Tech Perfect Inc. You are working in a spreadsheet. You observe that while trying to
look up or match a lookup_value within an array, Excel is not able to recognize the matching value. Which of the
following are the reasons that are causing the above problem? 

Each correct answer represents a complete solution. Choose all that apply. 

A. The lookup_value or the array you are searching resides in a cell containing unseen spaces at the start or end of that
cell. 

B. The contents of the cells that are being compared may have different data types. 

C. Excel is trying to reference an invalid cell. 

D. You are inserting a new column, next to a column that is already formatted as text. 

Correct Answer: AB 

The Failure to Look Up Values in Excel error occurs when a user gets an unexpected error while trying to look up or
match a lookup_value within an array and Excel is not able to recognize the matching value. If the lookup_value or the
array the user is searching resides in a cell, the user can have unseen spaces at the start or end of that cell. This will
create the situation where the contents of the two cells that the user is comparing look the same but extra spaces in one
of the cells cause the cells to have slightly different content. The other reason is that the contents of the cells that are
being compared may have different data types. Answer option C is incorrect. The Lookup Function Won\\'t Copy Down
to Other Rows error occurs when a user uses a function in one cell and it works perfectly but when he attempts to copy
the function down to other rows, he gets the #REF error. The #REF! error arises when Excel tries to reference an invalid
cell. This error occurs if the user has referenced an entire worksheet by clicking on the grey square at the top left of the
worksheet. For Excel, this reference range is 1 to 1048576. Since the references are Relative References, Excel
automatically increases the row references when this cell is copied down to other rows in the spreadsheet. Answer
option D is incorrect. The Excel Won\\'t Calculate My Function error occurs when a user types in a function and presses
Enter, the cell shows the function as the user typed it, instead of returning the function\\'s value. The reason that causes
this problem is that the cells containing the formula are formatted as \\'text\\' instead of the \\'General\\' type. This
happens when the user inserts a new column, next to a column that is already formatted as text due to which the new
column inherits the formatting of the adjacent column. 

 

QUESTION 8

You work as an Office Assistant for Tech Perfect Inc. You are working in the spreadsheet of the company\\'s high selling
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products. You are trying to intersect two ranges that do not intersect each other. Which of the following errors will be
occurred in this situation? 

A. #VALUE! 

B. #NAME? 

C. #NULL! 

D. #DIV/0! 

Correct Answer: C 

The #NULL! error is produced by Excel when a user attempts to intersect two ranges that do not intersect each other.
This error can be resolved by reviewing the formula and then either by changing the variables to ensure that the user is
getting a valid intersection or by using the Excel Iferror function to identify a null range and take the required action.
Answer option D is incorrect. Excel #DIV/0! is produced when a formula attempts to divide by zero and a division by
zero produces infinity that cannot be represented by a spreadsheet value. This error can be corrected or overcome by
using the Excel IF function to identify a possible division by zero and produce an alternative result. Answer option A is
incorrect. The #VALUE! Excel formula error occurs when any of the variables in a formula is of the wrong type. To
correct this error, it is required to check each individual part of the formula to make sure that the correct argument types
are used. If the function contains nested functions, the best way is to copy each of the arguments into a separate cell to
check what they evaluate to. If the formula contains a number of terms, break down each term further to find out its
components, until the source of the error is found. Answer option B is incorrect. The #NAME? error occurs when Excel
encounters text in a formula and tries to interpret that text as a reference, a named range, or a function name but is not
able to recognize the text as any of these. The best way to approach the #NAME? Excel function error is to check the
correct spelling of the function names, references, and named ranges and to check that the variables used as text
values are entered in double quotes. If the formula contains nested functions, it is required to check the results of these
individually, until the source of the error is identified. 

 

QUESTION 9

You work as an Office Assistant for Peach Tree Inc. Your responsibility includes creating sales incentive report of all
sales managers for every quarter. You are using Microsoft Excel to create a worksheet for preparing the report. You
have inserted the sales figures of all sales managers as shown in the image given below: 

You have to calculate the first quarter incentives for all sales managers. The incentive percentage (provided in cell B3)
is fixed for all sales managers. The incentive will be calculated on their total first quarter sales. You have to write a
formula in the cell F8. Then you will drag the cell border to the cell F12 to copy the formula to all the cells from F8 to
F12. In the first step, you select the F8 cell. Which of the following formulas will you insert to accomplish the task? 

A. =andBand3/100 * E8 

B. =B3/100 * E8 

C. =B3/100 * andEand8 

D. =$B$3/100 * E8 

E. =B3/100 * $E$8 

Correct Answer: D 

In order to accomplish the task, you will have to insert the following formula: 
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=$B$3/100 * E8 

According to the question, the formula will be inserted in cell F8 and then the cell\\'s border will be dragged to the F12
cell. Furthermore, the incentive percentage is fixed for all sales managers 

and the value is provided in the cell B3. You will have to insert a formula that refers to the B3 cell as an absolute
reference. For this you will have to type currency symbol ($) before the row 

name and column number. In order to accomplish the task, type the following formula in the cell F8: 

=$B$3/100 * E8 

When absolute reference is used for referencing a cell in a formula, dragging cell\\'s border to another cell does not
change the cell\\'s reference. Answer options B and E are incorrect. This formula references the B3 cell as a relative
reference. 

After inserting the formula, when the cell\\'s border is dragged, it will change the cell reference relatively. 

Answer options A and C are incorrect. Ampersand symbol (and) is not used for referencing cells in Excel. 

 

QUESTION 10

You work as an Office Assistant for Tech Perfect Inc. You are working in the spreadsheet of the company\\'s high selling
products. You want to find out the matching values. You get an unexpected error that when you attempt to look up or 

match a lookup_value within an array, Excel is not able to recognize the matching value. Which of the following steps
will you take to resolve the problem? Each correct answer represents a part of the solution. 

Choose all that apply. 

A. Remove the unseen spaces at the start or end of the first Macro cell. 

B. Delete the column having the TRIM function. 

C. Copy the contents of the new column and paste them on the top of the original column by using paste > special >
values sequence. 

D. Create a new column subsequent to the one with the additional spaces in it. 

E. Use the TRIM function in the new column. 

Correct Answer: BCDE 

In this situation, you will take the following steps: 

1.

 Create a new column subsequent to the one with the additional spaces in it. 

2.

 Use the TRIM function in the new column to get rid of extra spaces. 

3.
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 Copy the contents of the new column and paste them on the top of the original column by using paste > special >
values sequence. 

4.

 Delete the column having the TRIM function. Answer option A is incorrect. This is an invalid answer option. 

 

QUESTION 11

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. You have changed
some data in the worksheet of the company. You are submitting the sell workbook of the company to the Administrator
of the company for comments. Now, you want to merge input that you receive into a copy of that workbook, including
the changes and comments that you want to keep. For this purpose, it is required to access and use the stored change
history. Which of the following will you use to accomplish the task? 

A. Slicer-enabled highlighting 

B. Onscreen highlighting 

C. Reviewing of changes 

D. History tracking 

Correct Answer: C 

The following ways are provided by Excel to access and use the stored change history: 

1.

 Onscreen highlighting: It is used when a workbook does not contain many changes and a user wants to see all
changes at a glance. 

2.

 History tracking: It is used when a workbook has many changes and a user wants to investigate what occurred in a
series of changes. 

3.

 Reviewing of changes: It is used when a user is evaluating comments from other users. Answer option A is incorrect.
This is an invalid answer option. 

 

QUESTION 12

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. Some employees have
changed some data in the worksheet of the company. You want to identify changes that were made to the data in the
workbook and then take a decision whether to accept or reject those changes. For this purpose, it is required to access
and use the stored change history. 

Which of the following will you use to accomplish the task? 

Each correct answer represents a complete solution. Choose all that apply. 
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A. History tracking 

B. Onscreen highlighting 

C. Slicer-enabled highlighting 

D. Reviewing of changes 

Correct Answer: ABD 

The following ways are provided by Excel to access and use the stored change history: 

1.

 Onscreen highlighting: It is used when a workbook does not contain many changes and a user wants to see all
changes at a glance. 

2.

 History tracking: It is used when a workbook has many changes and a user wants to investigate what occurred in a
series of changes. 

3.

 Reviewing of changes: It is used when a user is evaluating comments from other users. Answer option C is incorrect.
This is an invalid answer option. 

 

QUESTION 13

You work as a Sales Manager for Tech Perfect Inc. You are creating a report for your sales team 

Using Microsoft Excel. You want the report to appear in the following format: 
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You want the Remark column to be filled through a conditional formula. The criteria to give the remark is as follows: 

If the sales of the First Quarter are greater than or equal to 1200, display "Well Done" If the sales of the First Quarter is
less than 1200, display "Improve in Next Quarter" 

You have done most of the entries in a workbook. You select the F2 cell as shown in the image given below: 

Which of the following conditional formulas will you insert to accomplish the task? 

A. =IF(E2>=1200,"Improve in Next Quarter","Well Done") 

B. =IF(E2=1200,"Well Done","Improve in Next Quarter") 

D. =IF(E2>1200,"Improve in Next Quarter","Well Done") 

Correct Answer: C 

In order to accomplish the task, you will have to insert the following formula in the F2 cell: 

=IF(E2>=1200,"Well Done","Improve in Next Quarter") Answer option A is incorrect. This will display the wrong
messages for the given conditions. 

The first expression after the logical condition is returned by the IF function when the condition is TRUE. 

Answer option B is incorrect. This formula will not accomplish the task as the logical condition is not correct. The
specified condition in this formula is testing for values less than or equal to 1200. Whereas, the question\\'s requirement
is to 
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evaluate values greater than or equal to 1200. 

Answer option D is incorrect. This formula will not accomplish the task because of the two reasons. 

First, the equal sign is missing in the condition. Second, the expressions are not in the correct order. 

 

QUESTION 14

You work as an Office Assistant for Blue well Inc. The company has a Windows-based network. You are creating a hot
spot on a graphic that other users can click to run a macro. Which of the following steps will you take to accomplish the
task? 

Each correct answer represents a part of the solution. Choose all that apply. 

A. To assign an existing macro to the graphic object, double-click the macro or enter its name in The Macro name box. 

B. Click the arrow next to Shape Outline, and then click No Outline. C. Right-click the created hot spot, and then click
Assign Macro. 

C. To create a hot spot on the existing object, on the Insert tab, in the Illustrations group, Click Shapes, select the shape
that you want to use, and then draw that shape on the existing object. 

D. Click the name of the macro in the Macro name box, click Edit, and then click OK to edit an existing macro. 

E. Click the arrow next to Shape Fill, and then click No Fill on the Format tab. 

F. Click Record, type a name for the macro in the Record Macro dialog box, and then click OK to start the recording of
the macro. 

G. Select the hot spot in the worksheet to display Drawing Tools for adding the Format tab. 

H. Click Slicer, type a name for the macro in the Slicer Macro dialog box, and then click OK to start the recording of the
macro. 

Correct Answer: ABCDEFGH 

 

 

QUESTION 15

You work as an Office Assistant for Media Perfect Inc. You have created a spreadsheet in Excel 2013 and shared it with
the other employees of the company. You want to protect the worksheet and locked cells by permitting or prohibiting
other employees to select, format, insert, delete, sort, or edit areas of the spreadsheet. Which of the following options
will you use to accomplish the task? 

A. Mark as Final 

B. Encrypt with Password 

C. Protect Current Sheet 

D. Protect Workbook Structure 
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Correct Answer: C 

The various Protect Workbook options are as follows: 

1.

 Mark as Final: This option is used to make the document read-only. When a spreadsheet is marked as final, various
options such as typing, editing commands, and proofing marks are disabled or turned off and the spreadsheet becomes
read-only. This command helps a user to communicate that he is sharing a completed version of a spreadsheet. This
command also prevents reviewers or readers from making inadvertent modifications to the spreadsheet. 

2.

 Encrypt with Password: When a user selects the Encrypt with Password option, the Encrypt Document dialog box
appears. In the Password box, it is required to specify a password. Microsoft is not able to retrieve lost or forgotten
passwords, so it is necessary for a user to keep a list of passwords and corresponding file names in a safe place. 

3.

 Protect Current Sheet: This option is used to select password protection and permit or prohibit other users to select,
format, insert, delete, sort, or edit areas of the spreadsheet. This option protects the worksheet and locked cells. 

4.

 Protect Workbook Structure: This option is used to select password protection and select options to prevent users from
changing, moving, and deleting important data. This feature enables a user to protect the structure of the worksheet. 

5.

 Restrict Permission by People: This option works on the basis of Window Rights Management to restrict permissions. A
user is required to use a Windows Live ID or a Microsoft Windows account to restrict permissions. These permissions 

can be applied via a template that is used by the organization in which the user is working. These permissions can also
be added by clicking Restrict Access. 

6.

 Add a Digital Signature: This option is used to add a visible or invisible digital signature. 

It authenticates digital information such as documents, e-mail messages, and macros by using computer cryptography.
These signatures are created by specifying a signature or by using an image of a signature for establishing authenticity, 

integrity, and non-repudiation. 
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